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Preface 

 

 

In TMM4160 fracture mechanics course, you will not only master the fracture mechanics 

theory. You will also learn to use the finite element program ABAQUS to calculate the 

fracture mechanics parameters (J, K and CTOD). This documentation is intended to cover the 

minimum you need to finish the computational exercises. For deepening in finite element 

method please refer to finite element method courses at Dept. of Structural Engineering. 

Modern finite element programs have advanced to such a degree that it is very easy to obtain 

results and color plots. It is therefore very important to take your time to critically 

judge/understand your results and link the results to fracture mechanics theory. 

 

 

 

Zhiliang Zhang 

Professor of Mechanics and Materials 

Dept. of Structural Engineering 

Email: zhiliang.zhang@ntnu.no 

http://folk.ntnu.no/zhiliang/ 

http://www.ntnu.edu/nml 

mailto:zhiliang.zhang@ntnu.no
http://folk.ntnu.no/zhiliang/
http://www.ntnu.edu/nml


Manual for the computational exercise in TMM4160 Fracture Mechanics                  Page 4 of 32 

 Problem Definition 

Fracture mechanics concerns the interaction of the applied crack driving force and materials 

fracture resistance. For simple geometry and linear elastic materials fracture parameters can 

be easily calculated based on existing analytical equations. For complicated geometry and 

elastic-plastic materials finite element method is necessary. The main purpose of these 

computational exercises is to use ABAQUS to calculate the fracture parameters of a 2D plane 

strain single edge notched specimen. 

1.1  Specimen geometry 

The dimension of specimen is shown in Figure 1. The crack size (a) is 20 mm, specimen depth 

(w) is 50 mm and length (L) is 300 mm. 

 

 
Figure 1. Dimensions of the specimen considered in this course 

 

1.2  Materials 

Four materials will be considered in this exercise: one linear elastic and three elastic-plastic. 

 

A linear elastic material (E1) will be considered first. Linear elastic material is relevant for 

the computation of stress intensity factor K. Typical stress-strain curve for a linear elastic 

material is shown in Figure 2. There are two materials constants associated with a linear 

elastic material: Young’s modulus E and Poisson ratio ν. 

 

 
Figure 2. Linear elastic material stress-strain relation. 

 

The next step in your exercise is to consider more realistic engineering materials, such as steel 

alloys, which are elastic-plastic materials (EP0, EP1, EP2). The behavior of such material 

consists of elastic, yielding and plastic behavior. Typical elastic-plastic stress-strain relation is 

shown in Figure 3a). It should be noted that in ABAQUS the elastic-plastic behaviors are 

defined separately. The stress-equivalent plastic strain curve (Figure 3b) is used for defining 

E 

 



a=20mm 

w=50mm 

L=300mm 



Manual for the computational exercise in TMM4160 Fracture Mechanics                  Page 5 of 32 

the plastic behavior in ABAQUS (not the stress-strain curve of Figure 3a). Materials stress-

strain curve (Figure 3a) is usually obtained from uniaxial tensile tests. 

 

        
a)      b) 

Figure 3. a) Stress-strain curve for an elastic-plastic material and b) stress-equivalent plastic strain 

curve needed for ABAQUS input. 

 

Materials  E1 

 

EP0  

(n=0) 

EP1 

(n=0.10) 

EP2 

(n=0.20) 

Young’s Modulus [MPa] 200000 200 000 200 000 200 000 

Poisson Ratio 0.3 0.3 0.3 0.3 

Plastic behaviour  ep  f [MPa] ep  f [MPa] ep  f [MPa] 

0.0 400 0.0 400 0.0 400 

0.8 400 0.02 508 0.02 646 

  0.04 542 0.04 735 

  0.06 564 0.06 795 

  0.08 580 0.08 841 

  0.10 593 0.10 878 

  0.15 617 0.15 951 

  0.20 635 0.20 1007 

  0.30 661 0.30 1091 

  0.40 680 0.40 1155 

  0.50 695 0.50 1208 

  0.60 708 0.60 1252 

  0.80 728 0.80 1326 

Table 1. Materials used in the exercise 

 

In this exercise “model-materials” will be considered. Following elastic-plastic material 

model with three different plastic strain hardening exponents will be used. 

 

0

0

1

n
p

f


 



 
  

 
     (1) 

 

where n is the strain hardening exponent, 0 , 0 0 / E   are the yield stress and yield strain, 

f  and 
p  are the flow stress and equivalent plastic strain, respectively. The yield stress for 

all the three elastic-plastic materials is the same 0 =400 MPa. In order to facilitate your 

inputs of material behavior in ABAQUS, equation (1) has been tabulated and the materials 

have been categorized in the following table. The material EP0 where n=0 corresponds to a 

perfectly plastic material i.e. no strain hardening occur. 

ep 

  

Yield stress 

Elastic 

Plastic strain hardening 


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1.3  Loading and boundary conditions 

Same specimen shown in Figure 1 will be used for the analyses of tension (Figure 4a) and 

bending (Figure 4b) problems.  

 

   
 

a)        b) 

Figure 4. a) singe edge notched tension and b) single edge notched bending 

 

Both the boundary conditions and loadings are symmetrical. By using the symmetry half of 

the specimen should be used. Figure 5 suggests the half models to be used. 

    
a)        b) 

Figure 5. a) half tension model and b) half bending model 

 

2.  Preliminary about ABAQUS/CAE 

2.1  Units in ABAQUS 

Before starting to define any model, you need to decide which system of units you will use. 

ABAQUS has no built-in system of units. All input data must be specified in consistent units. 

 

Quantity SI SI(mm) 
Length m mm 

Force N N 

Time s s 

Stress Pa(N/m
2
) MPa (N/mm

2
) 

Young’s modulus Pa(N/m
2
) MPa (N/mm

2
) 

Table 2. Common consistent units 

 

In this exercise it is suggested that SI (mm) units will be used. That means that the units for 

length, force, and Young’s modulus will be mm, N and MPa, respectively. Young’s modulus 

usually dictates the units of other quantities. 

 

P/2 
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2.2  File types in ABAQUS 

ABAQUS/CAE is a complete environment that provides an interface for creating, submitting, 

monitoring, and evaluating results from ABAQUS solvers named ABAQUS/ Implicit and 

ABAQUS/Explicit. ABAQUS/Explicit is mainly for dynamic and transient problems. In this 

course we will limit our self to ABAQUS/Implicit. 

 

There are two major file types in ABAQUS/CAE: 

 

 *.cae – file, which contains all the modeling (pre-processing) data and information.  

 *.odb – file, which contains the analysis results. 

 

When you run analyses with ABAQUS, all the files (including the odb – file) will be stored 

on the TEMP-directory of the computer you use. You can modify this location in “File → Set 

Work directory” and set the file where you store the cae – file for instance. Also please 

name the analyses systematically in a way you can easily identify analysis afterwards. DO 

NOT put more than one analysis in a cae – file. If you are to change only the material, you 

should make a copy of the cae – file and rename/edit the copy. If you have more than one 

analysis in the same file, you can be sure you will mix up the different analyses quite soon.  

 

It is suggested that you make a directory where you keep all the files for this exercise. By the 

end of the course you will have quite a lot of files, so it is important to be able to distinguish 

them from the very beginning. 

 

ABAQUS is a comprehensive program and is well documented. A complete set of online 

ABAQUS manuals can be found (the exact path could be dependent on the installation): 

 

 Start → ABAQUS 6.12  →  ABAQUS Documentation 

 

2.3  Starting ABAQUS/CAE 

Always bring the “Fracture Mechanics” textbook with you. You will regularly need to recover 

some theory and results should be compared with some of the plots or equations in the book. 

 
 Start → ABAQUS 6.12 → ABAQUS CAE → Create Model Database 

 

You will get the following starting panel of the ABAQUS/CAE. 

 

 

Create a new model 

Open an existing 
cae or odb file 

(Fluid module) 
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2.4  Different Modules in ABAQUS/CAE 

ABAQUS/CAE is divided into modules, where each module defines an aspect of the 

modeling process; for example, defining the geometry, defining material properties, and 

generating a mesh. As you move from module to module, you build the model from which 

ABAQUS/CAE generates an input file that you submit to the ABAQUS/Standard or 

ABAQUS/Explicit solver for analysis. For example, you use the Property module to define 

material and section properties and the Step module to choose an analysis procedure. The 

ABAQUS/CAE postprocessor is called the Visualization.  

 

You can enter a module by selecting it from the Module list under the toolbar, as shown in 

Figure 6.  Also, you will find the equivalent of all modules in the Model tree. 

 
  

 
Figure 6.  Different modules in ABAQUS/CAE 

 

3.  Creating a Finite Element Model with ABAQUS/CAE 

3.1  Create a Part for the half model 

Parts define the geometry of the individual components of your model and, therefore, are the 

building blocks of an ABAQUS/CAE model. You can create parts that are native to 

ABAQUS/CAE, or you can import parts created by other applications either as a geometric 

representation or as a finite element mesh. You will start the half tension problem by 

creating a two-dimensional, deformable shell part. You do this by sketching the geometry of 

the specimen. ABAQUS/CAE automatically enters the Sketcher when you create a part. 

 

 Enter the ABAQUS/CAE “Part” module. The Model Tree appears in the left side of 

the main window. Between the Model Tree and the canvas is the Part module toolbox. 

A toolbox contains a set of icons that allow the users to bypass the menus in the main 

menu bar. For many tools, as you select an item from the main menu bar or the Model 

Tree, the corresponding tool is highlighted in the module toolbox so you can learn its 

location. In the following we will use the icons frequently. In this exercise we will use 

the icons as much as possible.  

 

Different modules 

Modelling: working on cae file 

Results: working on odb file 

Model 

tree 
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ABAQUS/CAE often displays a short message in the prompt area indicating what you should 

do next, as shown in Figure 7.  Click the Cancel button to cancel the current task. Click the 

Previous button to cancel the current step in the task and return to the previous step. 

 

 
Figure 7. Messages and instructions are displayed in the prompt area. 

 

 In the Model Tree, double-click the Parts container to create a new part. The Create 

Part dialog box appears. ABAQUS/CAE also displays text in the prompt area near the 

bottom of the window to guide you through the procedure. You use the Create Part 

dialog box to name the part; to choose its modeling space, type, and base feature; and 

to set the approximate size. You can edit and rename a part after you create it; you can 

also change its modeling space and type but not its base feature. 

 

Tips: In all tools in ABAQUS/CAE, if you simply position the cursor over a tool in the 

Sketcher toolbox for a short time, a small window appears that gives a brief description of the 

tool. When you select a tool, a white background appears on it. 

 

 
 

 Choose 2D planar, deformable, shell and approximate size 300. Click Continue to exit 

the Create Part dialog box and enter the sketcher window. 

 

 Use  or   in the “Part” module toolbox create a rectangular part with 

dimension 150x50mm. Draw a rectangle and then constrain your sketch by adding 

appropriate dimensions using . If you want to modify a dimension, you may use 
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. Use  to auto fit the view. You will get the following figure. If you made 

some mistakes, you can always use  to delete the components you created. The 

position of your figure in the sketch is not important for that exercise. 

 

 
 

 Click “Done” to exit the sketch and return to the part module. ABAQUS/CAE uses 

the top-down methodology to create the model. You model the global geometry first 

and model the local features afterwards. Now you have created a region for the model.  

 

 
 

 Click the “Partition tool”  to cut the region into different sub-regions for 

different mesh density.   
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Before you start to partition, you can use the sketcher option  to adjust the grids and align 

the origin. 

  

 
 

 Use   to create 11 lines (in yellow color). You can always use the right mouse 

button or push “Esc” to stop the procedure during creating the lines. The position of 

the points connecting the lines can be easily calculated from the dimensions given 

below. In fracture mechanics, because of the stress/strain concentration at the crack tip, 

we need to create fine mesh at the crack. In the region far away from the crack tip, 

course mesh can be used. In total there are 8 sub-regions in this model and there are 

two small regions around the crack tip.  

 

 
 

 Once you have created these sub-regions, click “Done” and return to the part module. 

Now you have created a part for the half crack model with appropriate partitions. 

 

Use this tool to create sub-regions 

Click this to align the origin to 
the left bottom corner 
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 Click  save the model to a file. Once you move to a new module always click 

. Before you close ABAQUS, copy the file to your home directory! 

 

3.2  Assign the Material Properties 

Next step is to create materials and the linear elastic material E1 will be analyzed first. 

Choose “Property” module and click  to create the material, or alternatively, double 

click “Material” in the left tree. As you can see in the following figure, there are a lot of 

possibilities in ABAQUS, but in these exercises, we will only consider simple isotropic 

material models. When the material properties are entered, click OK. You can always use 

 to edit the material, section and section assignment if necessary, or alternatively, right 

click on the corresponding items in the left tree and choose “Edit”.  

 

 
 

 Create a section. Now the material is defined, but it is not linked to any regions. To do 

so, we must specify a connection between the material and the regions. This 

connection is called “Section”.  Click  to create a section based on the material, 

or alternatively, double click “Section” in the left tree.  
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The section is the connection between the material properties and the regions, a material must 

be selected. If the model has only one material, the material will appear in the box 

“Material”. For models with several materials, you will have to select the correct material for 

the section. The model you are going to analyse is a so-called plane-strain model, so the 

thickness is set to unity. This is why the thickness value of 1 is preset in the text-box “Plane 

stress/strain thickness”. Of course you can specify a different value if you want. Remember 

the force applied to the model is proportional to the specified thickness.  

 

 You need to connect the section to the regions now. To do so, go to , or 

alternatively in the left tree, develop the “Part” module, and double click “Section 

Assignement”. Select all the regions in the part, and click “Done” at the bottom of the 

window, and following window will appear. Now select the correct section (in this 

model, you only have one section, so this will be pre-selected), and click “OK”. Now 

the material is linked to all the regions in the part. In advanced modeling, same part 

could contain (sub-) regions with different materials. In this exercise, all the regions 

will have the same material. 

 

 
 

3.3  Define the Assembly 

Each “Part” that you create is oriented in its own coordinate system and is independent of the 

other parts in the model. Although a model may contain many “Parts”, it contains only one 

“Assembly”. You define the geometry of the assembly by creating “Instances” of a part and 

then positioning the instances relative to each other in a global coordinate system. An instance 

may be independent or dependent. Independent part instances are meshed individually, while 

You can give a 
section name 
here if you want 

Material you already defined 

We assume the thickness is 1 
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the mesh of a dependent part instance is associated with the mesh of the original part. For this 

exercise you will create a single independent instance of your half tension model. 

ABAQUS/CAE positions the instance so that the origin of the sketch that defined the 

specimen overlays the origin of the assembly’s default co-ordinate system. If using the left 

tree, develop the “Assembly” item, and double click “Instances” to create a new one. 

 

 
 

3.4  Configure the analysis Step 

Now that you have created your “Assembly”, you can configure your analysis. In this 

simulation we are interested in the static response of the half tension model with a half 

uniform tension 1 mm on the right hand side. 

 

 
 

The analysis will consist of two overall steps: 

- An initial step, in which you apply boundary conditions that constrain the specimen. 

- An analysis step, in which you apply displacement at the right hand side of the specimen. 

 

ABAQUS/CAE generates the initial step automatically, but you must create the analysis step 

yourself. You may also request output for any steps in the analysis.  

 

 In order to define the analysis steps afterwards, you need to create “Sets” (collection 

of nodes) for results output (you may not wish to output results for the whole model) 

and defining boundary conditions. In a model, usually there are parts of the boundary 

have the same boundary conditions and we can define the parts with the same 

boundary conditions as “Sets” in ABAQUS.  

 
Crack 

Ligament 

Remote 
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There are three sets in the half tension model to be created: Crack front, crack ligament and 

Tension. If using the left tree, double click “Sets” under “Assembly”, otherwise choose 

Tools in the top menu bar, then Set and Create. Note that you should press “Shift” on your 

keyboard to select elements simultaneously. 

 

 
 

 In the module “Step”, choose  to create a step. Alternatively, double click “Steps” 

in the left tree. You need to assign some general values in “Basics” and 

“Incrementation” options. 

 

The time period in a static analysis does not have any physical meaning. Time period “1” 

means the total time to perform the analysis of given displacement/load is “1” – 100% of the 

applied displacement will be used. 

 

 
 

 Turn off the “Nlgeom” option. ABAQUS analyses can include and exclude the 

nonlinear effects of large deformations. The nonlinear geometrical effects (large 

deformation) will be neglected in this exercise. 

 

By default, ABAQUS/CAE writes the results of the analysis to the output database (.odb) file. 

When you create a step, ABAQUS/CAE generates a default output request for the step. A list 

of the preselected variables written by default to the output database is given in the ABAQUS 

Analysis User’s Manual. You do not need to do anything to accept these defaults.  

You use the “Field Output Requests Manager” to request output of variables that should be 

written at relatively low frequencies to the output database from the entire model or from a 

large portion of the model. You use the “History Output Requests Manager” to request 

Give some key words about your problem 

Crack front Tension Crack ligament 
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output of variables that should be written to the output database at a high frequency from a 

small portion of the model; for example, the displacement of a single node. 

 

 Use   to define field output request, or alternatively double click “Field Output 

Requests” in the left tree. The default one is of no interest for you, so you can either 

delete it and create a new one, or modify it to take into account only Stresses, Strains 

and Displacement/Velocity/Acceleration.  

 

 
 

 Use  to define history output request, or alternatively double click “History 

Output Requests” in the left tree. You can delete the default one (you do not need it) 

by right clicking on it and selecting “Delete”. Three history output requests can be 

made. The reaction output at set Crack ligament, and displacement output at sets 

Crack front and Tension. 
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3.5  Apply the load and boundary conditions 

Prescribed conditions, such as loads and boundary conditions, are step dependent, which 

means that you must specify the step or steps in which they become active. After that you 

have defined the steps in the analysis, you can define prescribed conditions. 

 

In structural analyses, boundary conditions BCs are applied to the regions of the model where 

the displacements and/or rotations are known. Such regions may be constrained to remain 

fixed (zero displacement and/or rotation) during the simulation or may have specified, non-

zero displacements and/or rotations. The BCs for the half tension model are: 
 

 
 

1 mm 
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The labeling convention used for the displacement and rotational degrees of freedom in 

ABAQUS is shown in the following: 

 

 
 

 In the module “Load” (or “BCs” in the left tree), use  to assign the symmetric 

boundary conditions at the crack ligament in the initial step. This symmetry 

condition is already implemented in Abaqus, and is called X-Symm. 

 

 
 

 The model should have no rigid body motion in the vertical direction. Use  again 

to fix the vertical displacement U2 at the left-bottom corner. This boundary 

condition should be defined in the initial step. 

 

 
 

Symmetrical 
boundary 
condition 
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 Use  to create the uniform displacement boundary condition at right edge in the 

static step. Here “U1: 1” means that the displacement at the end of this analysis step 

will be 1 mm. The displacement increases from 0 mm (time =0) to 1 mm (time=1). 

 

 
 

 

Final boundary conditions for the half tension model look like this: 

 

 
 

The loading in the tension model is controlled by the displacement and there is no 

concentrated/distributed loading in this tension model. If you wish, the horizontal 

displacement can be replaced by distributed loading by clicking , or double clicking 

“Loads” in the left tree. 

 

3.6  Mesh the model 

You will now generate the finite element mesh in the module “Mesh”. Before you generate 

the mesh, you must specify the element type, the element size and the mesh generation 

technique.  

 

 Click  to choose the element type – “plane strain” with “non-reduced 

integration” for this exercise. This element is called CPE4. 

 

Uniform displacement 
1 mm 
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 Use  to specify the mesh generating technique – “Structured” technique for quad 

element shape. After “OK” the colors will shift to green which means the 

“Structured” technique can be applied in these regions. 

 

 
 

 Click on the “Seed edges” icon  to assign the mesh seeds along the edges of all 

the regions. Select the edge(s) first and click on “Done”. Select “by number” in the 

“Local seed” windows newly opened and enter the number afterwards. The suggested 

numbers of elements along the edges are shown in the following figure: 

 

 

30 elements 

30 

30 

10 

10 
10 10 

10 

10 

10 

10 

10 

10 
10 

10 

10 

10 

10 

10 

10 

10 

10 

 
 

 Click  to generate the mesh for the model. Finally you will get a mesh like this: 

 

 
 

Note that if you click   for a while you will get more options with  . The same 

is true for   →  . In the left tree, the mesh can be found under 

“Assembly”, then “Instance”, and “Part”. 
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3.7 Create an analysis job 

Now that you have configured your analysis, you will create a job that is associated with your 

model. Shift to the “Job” module.  

 

 Click   to generate the job, or alternatively, double click “Jobs” in the left tree. 

 

 
 

 Choose job manager  to submit and monitor the job, or alternatively, righ click on 

your job in the left tree, and select “Submit” and/or “Monitor”. 

 

 
 

 If there is no error and the job finished properly the status will become “Completed” 

and click the “Results” to automatically enter the “Visualization” module. 

Alternatively, right click your completed job, and select “Results”. 

  

 YOU HAVE TO ASK FOR THE RESULTS, entering the visualization mode is not 

enough. Failing to do that will induce post-processing results from a previous job! 

  

 

for debugging 

Assign a name 
if you want 
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3.8  Post-processing the results 

3.8.1 Graphical plots  

The “Visualization” module of ABAQUS/CAE allows you to view the results graphically 

using a variety of methods, including deformed shape plots, contour plots, vector plots, 

animations, and X–Y plots. You can save those plots to illustrate your report by using “print 

screen” or In addition, it allows you to create tabular reports of the output data. For more 

information on any of the post-processing features discussed in this guide, consult 

ABAQUS/CAE User’s Manual.  

 

You can enter the “Visualization” module either by clicking the “Results” in the Job 

Manager window or click “Visualization” in the Module list located under the toolbar and 

select “File → Open”, select the job.odb, where job is the job name you assigned.  

 

 You can use  and  to create fast contour and deformed plots.   

 

 
 

The orientation triad indicates the orientation of the model in the global coordinate system. 

You can suppress the display and customize the title block, state block, and view orientation 

triad by selecting “Viewport → Viewport Annotation Options” from the main menu bar. 
 

 If you want to display the node (or element) number in the visualization module, go to 

“Options → Common → Labels” and toggle on “Show node labels” (or element). 

Deformation in the deformed plots can also be scaled. You can go to “Basic” to 

change the deformation scale factor  
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3.8.2 Global load-displacement curves 

In finite element analysis it is important to plot the global load-displacement curve. When the 

job is completed, go to “Create XY Data”   in the “Visualization” module to plot the 

global load-displacement curves. It is very important that you copy-paste and save the curves 

you build to an excel file, since the created XY-data and XY-plots will not be saved in your 

results file. As soon as you close the Abaqus windows, they will be deleted, and you will have 

to create them once again afterwards. 

 

 Choose “Odb history output”, select “Spatial displacement U1” at any node in the 

set “Tension” (because all the nodes in the tension set have identical displacement 

history) and click “plot” to get the time – remote displacement curve. 

 

 
 

 “Save as” the curve with a name. We can use the XY Data Manager    to 

manipulate the curve later. 

 

 
 

 Go to “Odb history output” again, select “Reaction force RF1” at all the nodes in 

the set “Crack Ligament” and plot. It is important to select all the nodes. Otherwise 

the total reaction force calculated will not be accurate. You will get a lot of time-

reaction force curves. The individual reaction force at each node is not interesting for 

us. We are interested in the total reaction force.  Choose “Save as” and “Sum” and 

assign a meaningful name to the quantity. Note: the total reaction force is negative in 

this model, because it points to the negative direction.  

 

Now you have saved both the time-displacement and time-total reaction force curves for the 

model. From these two curves you can obtain the global displacement-load curve. 
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 You obtain the values for each data (columns) previously saved by going to the “XY 

Data Manager”  . Choose the curve you are interested in and click on “Edit”. 

For the previously saved time-displacement curve for instance, the X column is the 

time and the Y column is the displacement.  

 

 You can copy columns in an Excel file to generate new plots. For instance take the Y 

column of “time-displacement” and the Y column of “time-total reaction force” to 

later plot “displacement-total reaction force”. You can also directly export the data to 

a text file: “Report → XY…  

 

 
 

Select the XY-plot you want to export. Then select the tab “Setup” to tell ABAQUS/CAE 

where to store the file, and how the data should be presented. The first option is the filename. 

Note the check-box below the name-field “Append to file” is pre-checked, which means that 

the data will be added to the end of the file if it exists. The other options can just be as they 

are (in general). By clicking the button “OK”, the data is written to the file. The file 

containing the XY-data will be saved in C:\TEMP as default. 

 

 If you want to work in the ABAQUS/CAE environment, prepare the plot of global 

displacement-load curve by opening a “Keyboard” table: 
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 “Edit XY data” for the time-displacement data and copy the Y column (displacement) 

to the X column in the XY Data from Keyboard window. In a similar way, “Edit 

XY data” for the time-total reaction force data and copy the Y column (total reaction 

force) to the Y column in the XY Data from Keyboard window. Use “Plot” and 

“Save” to plot and save the global displacement-load curve. 

 

 
 

 You can use XY Plot Options  and XY Curve Options  to modify the 

appearance of the figures. 

 

3.8.3 Nominal stress-strain curve of a tension specimen 

Use the following equations to convert the global load-displacement curve of a tension 

specimen to its nominal stress-strain curve  

 

 
2

P U
,

A L /
    

 

where P is applied load, A the loaded specimen area and L is the specimen length. Note that 

the applied load P=-F, where F is the total reaction force. 

 

3.8.4 Bending stress of a bending specimen 

Sometime it is beneficial to use bending stress instead of global load for a bending specimen. 

The bending stress can be calculated 

 

 
3

2 12
b

M w w
, I

I
    

 

where M is the maximum bending moment, I the moment of inertia, and w the specimen 

width (see Figure 1). The bending moment can be calculated from the reaction force and half 

distance M=P/2*L/2=PL/4. 
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4.  Elastic Fracture Parameter 

4.1 Calculate the K based on stress distribution along the crack ligament  

Elastic fracture parameter - stress intensity factor (K) can be calculated from the stress 

distribution along the crack ligament. In order to display the stress distribution along a certain 

path, a path should be defined first in ABAQUS CAE Visualization module. 

 

 Go to “Tools → Path → Create → Node list” to create the crack ligament path. 

After picking the correct nodes click “Done”. The created path with node numbers 

will be highlighted. You can edit the path using “Path Manger”.  

 

 

 

 Once the Path is defined, you can go to Create XY Data  to plot the results. In the 

XY Data from path, you can first choose the right path (if there is more than one path 

available). Plot the results on the un-deformed shape and use true distance.  

 

 Click the “Step/Frame” option to choose the results at the last increment. Click the 

“Field output” to choose the right crack opening stress (S11). 
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 “Plot” the stress distribution. You get typical stress distribution curve shown in the 

following figures. If the peak stress value appears on the right hand side, it means the 

path was not defined starting from the tip. The path should be re-defined. 

 You can get logarithmic plot by using logarithmic type in “XY Plot Options”  

 

 
 

 Save the stress – distribution plot for computing the K value.  

 

Tips: The K can be either fitted from the stress distribution 
11 2IK r   or 

determined from the tangent of the logarithmic plot. The following figure shows how the 

K can be directly fitted from the stress distribution. It should be noted that the K you fitted 

is strongly related to the applied load level to the model. The value shown in the 

following figure may have no relevance to your case. The K can also be determined from 

the 11ln - ln r  log plot by using the following relation: 11 0 5
2

IK
ln ln . ln r



 
  

 
. 

 

 

Linear plot 

log plot 
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4.2 Define a crack to compute the J-integral 

The elastic stress intensity factor (K) can also be calculated from the J-integral, which is used 

for most cases as an elastic-plastic fracture parameter. In order to calculate the J-integral, a 

crack entity should be defined in ABAQUS. 

 

 Go to “Interaction” module, define the crack front (Interaction → Special → Crack) 

 Define the “crack normal”. Make sure that the normal is pointing outwards. Please 

also tell ABAQUS/CAE that the crack lies on the symmetrical plane.  

 The crack can be found in the left tree “Assembly/Engineering features/Cracks” 

     

4.3 Create History Output for the J-integral 

Once the crack is defined in the finite element model, you can create a new history output 

request for the J-integral. 

 Go to “Step” module and click , or use the left tree. In the “Edit History Output 

Request” window, choose “Contour integral” and a “Number of contours” of 10. 

 

 
 

 SUBMIT YOUR JOB AGAIN, the J-integral results will be available and go to “Odb 

History output” to post-process the J-integral- versus time data 

 

4.4 K-J relation for elastic materials 

Following classical relation can be used to calculate the K from the J-integral: 2J K E' , 

where E'  depends whether the problem is plane stress or plane strain. Consult the text book 

p.59 for details. 
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5.  Elastic-Plastic Fracture Parameters 

J-integral and CTOD are the two most common elastic-plastic fracture parameters. In order to 

calculate the elastic-plastic fracture parameters, you have to go to “Property” module to 

create a new elastic-plastic material (EP1, EP2 or EP3). 

5.1 Create elastic-plastic materials in ABAQUS 

 Input the elastic properties (Young’s modulus and Poisson’s ratio) first 

 Input the plastic properties (stress in 1
st
 column, plastic strain in 2

nd
 column) 

 

      

5.2 J-integral output 

The same procedure as before can be used to output the J-integral for elastic-plastic materials. 

5.3 Define the node for outputting CTOD/ CMOD 

To output the CTOD and CMOD you need to identify the corresponding node numbers. 

 

 In the “Visualization” module, go to “Options → Common Plot Options → Show 

node labels” to display the node numbers (as describe p. 23).   

 

 Note down the CTOD node and CMOD node numbers. Use “Odb history output” to 

output the time-CTOD and time-CMOD curves. You can further plot the global load-

CTOD/CMOD relations etc. 

 

 Another way to get this output is to create two new “Sets”. The first called “CTOD” 

contains the node corresponding to CTOD, and the second called “CMOD” contains 

the node corresponding to CMOD. You can then create 2 corresponding “History 

Output Request” to ask for the displacement (UT: Translations) linked to the sets 

CTOD and CMOD. SUBMIT YOUR JOB AGAIN and once in the visualization 

module, create a new XY-data and/or XY-plot to display CTOD and CMOD relations. 

 

The following figures are taken from the elastic case (E1 material), just to make it easier to 

spot CTOD and CMOD locations. 
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5.4 J-CTOD relations  

You can plot the J-CTOD curves, which depend on the material strain hardening exponents. 

 

6. Tension versus bending 

So far the tension model has been the focus. Select 

the E1 and EP1 materials, create a half bending 

model and compare the results with tension. The 

reaction force for the bending specimen can be easily 

calculated from point A in the following figure. To 

create that model, you should think about modifying 

the Boundary Conditions but also the History Output. 

  

7.  Mesh size effect 

The finite element mesh size will possibly influence your results. Select the EP1 material and 

make a new tension model with the following mesh specifications and compare the results. 

 

 

30 elements 

30 

30 

20 

20 
20 20 

20 

20 

20 

20 

20 

20 
20 

20 

20 

20 

20 

20 

20 

20 

 
 

You should keep in mind that a new mesh means new node numbering. Consequently, some 

of the output request and path need to be upgraded. The bending case can be treated only if 

you want to invest more but is not mandatory for the final report. 

Output CTOD 
from this node 

Output CMOD from 
this node 

 
1mm 

A 



Manual for the computational exercise in TMM4160 Fracture Mechanics                  Page 31 of 32 

8. Computational Fracture Mechanics Report 

8.1 Steps and time schedule (suggestion) 

This section gives an outline of the expected progress of the work, including deadlines and 

content of the intermediate ABAQUS exercises. The more time you use on the intermediate 

exercises the less time you need for the final report. All the curves are not mandatory in the 

final report. They are suggested to help your understanding of the problem. 

Week 36 to 37 - Create a FEM model with ABAQUS CAE 

Linear elastic material E1, tension model 

- Learn the ABAQUS CAE modeling concepts 

- Create the geometry, assign the material, apply the boundary conditions 

- Generate the mesh, perform the finite element analysis and view the results 

- Global load – displacement curve  

- Nominal stress – strain curve of the specimen (Young modulus?) 

Week 38 to 39 - Calculate the stress intensity factor K  

Linear elastic material E1, tension model 

- Define the path to get “Sigma11 – distance from the crack tip” curve 

- Calculate the K and discuss “K – Distance from the crack tip” curve 

- What about theoretical K in Anderson book? 

 

Intermediate ABAQUS exercise 1 – deadline Friday October 4
th

 
 

- Describe the problem and theoretical background of the stress intensity factor, K 

- Present and discuss the results you have so far 

Week 40 to 41 - Calculate the J-integral  

Material E1 and EP0, EP1, EP2, tension model and bending model (EP1 only) 

- Global load – displacement relation 

- Define the crack to get the J-integral 

- Discuss the J path independence (E1) 

- Calculate the K value from the J-integral (E1, EP1?) 

- “J – global load or global displacement” curves 

Week 42 to 43 - Calculate the CTOD  

Material E1 and EP0, EP1, EP2, tension model and bending model (EP1 only) 

- Define the CTOD/CMOD 

- “CTOD/CMOD – global load or global displacement” curves 

- CTOD – J relations  

- Discuss the linearity of the previous curves (m parameter?) 

Week 44 to 45 - Effect of mesh 

Elastic-plastic material EP1, tension specimen, finer mesh  

- Nominal stress – strain curve 

- Sigma11 – distance from the crack tip 

- J – global load relation 

- CTOD-global load relation 

- CTOD-J relation 
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8.2 Graded report 

Week 46 to 47 - Reporting 

A final semi-technical report on the computational exercises is expected. The report must 

consist of not only figures but also comments and discussions. The report will be graded 

over 25 points. Here are some suggestions for the organization of the report: 

 

 Problem definition, geometry and materials 

 Theoretical background (limited to the theory you need in the analysis of results) 

 Results and discussion 

o Tension (all materials) 

“Global load – displacement” curves for tension specimen, all materials  

Global and local deformed plots for tension E1, EP1  

“Nominal stress – strain” curve for the tension specimen, all materials 

“Sigma11 – distance from the crack tip” for E1 (EP1) and tension specimen 

“K – Distance from the crack tip” for E1 (EP1) and tension specimen 

“J – Nominal stress” curves for tension specimen, all materials 

“CTOD / CMOD – Nominal stress” curves for tension, all materials 

“CTOD – J” relations for tension specimen, comparison of four materials 

o Bending (E1 and EP1) 

“Global load – displacement” curves for bending specimen, E1 and EP1 materials 

Global and local deformed plots for tension and bending specimens, EP1 

“K – Distance from the crack tip” for E1 and bending specimen 

“J – Nominal stress” curves for bending specimen, E1 and EP1 

“CTOD / CMOD – Nominal stress” curves for bending specimen, E1 and EP1 

o Mesh sensitivity (tension, E1 and EP1) 

“Nominal stress – strain” curve, “Sigma11 – distance from the crack tip”, CTOD etc. 

 Conclusions : you can finally draw conclusions about what you have understood from 

the computational fracture mechanics exercises. 

 

Deadline ABAQUS final report: Friday November 15
th

  

9.  Computational Fracture Mechanics Networks 

http://cee-ux49.cee.uiuc.edu/cfm/home.html 

http://www.cfg.cornell.edu/ 

http://cee-ux49.cee.uiuc.edu/cfm/home.html
http://www.cfg.cornell.edu/

